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Microsoft Outlook is not the most intuitive program to use, even for peo-

ple who’ve used it before. The basics of creating a new message are the 

same in every email client, but Outlook has so many features and options 

that it’s easy to be overwhelmed by it. Our goal is to help you find your 

way around Outlook 2013 and turn you into an Outlook power user. 

If you’re new to Outlook, we’ll introduce you to the features Outlook 2013 

offers, not only for email, but also for Calendar, Contacts, and Tasks. If 

you’re upgrading from an older version of Outlook, you’ll learn about the 

new features in Outlook 2013 and discover some new tricks that will help 

you manage your life, or at least the part that is in Outlook. 

By the time you are finished reading this book, you’ll be more organized 

than ever and on the road to becoming an Outlook expert.

I N T R O D U C T I O N

INTRODUCTION
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What’s in This Book?
Beginning with an introduction to Outlook, you’ll discover the features in Outlook 
2013, including the Navigation pane, the Reading pane, Search Folders, and 
Quick Steps. You’ll learn how to set up your accounts and customize Outlook. 

Outlook is unlike any other email program. It supports common Internet email 
accounts using POP3 and IMAP protocols, free Outlook.com accounts, as well as 
corporate email hosted on Exchange Server. You’ll learn about the other features 
that make Outlook the most powerful messaging client available, such as voting, 
message tracking, and deferred delivery. Outlook’s Junk E-mail filter automatically 
removes most of the spam you receive from your Inbox as it’s downloaded, 
eliminating much of the spam before it takes over your life. We’ll show you how to 
set up your accounts and use email in Chapters 1-6. 

Although Outlook is a first-rate email client, it does more than just email. With 
Calendar, Contacts, and Tasks, it’s also a personal information manager (PIM). 
You’ll learn how to use these features to their fullest. Learn how to use categories 
to organize your contacts and calendar, and use your contacts in a mail merge. 
Finally, you will learn how to create recurring appointments and send meeting 
requests. We’ll show you how to use Calendar, Contacts, and Tasks in 
Chapters 7-9.

And let’s not forget the Social Connector—with LinkedIn and Facebook enabled, 
you’ll see your contacts’ smiling faces as you read their email messages and see 
your contact’s LinkedIn and Facebook photos and status updates in Outlook. You 
can learn about the Social Connector in Chapter 10.

Integration with other Office programs and online services is important to many 
users. In Chapters 12 and 13, we show you how to link SharePoint lists to Outlook 
and use Outlook contacts in Word. You can learn how to use mail merge in 
Chapter 20.

Managing your email is easier when you use the tools Outlook provides: Color 
Categories, Instant Search, Search Folders, and Rules. Views are one of our 
favorite power-user features, and we’ll show you how to work with the views that 
Outlook includes and how to create your own custom views. You’ll find this in 
Chapters 14-17. 

In Chapter 18, we’ll show you how to print your email, calendar, and contacts. 
Learn about Outlook data files and how to back up your email, calendar, and 
contacts in Chapter 19.
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• Organizing messages into folders

• Automating your Inbox with Quick Steps

• Sending incoming email to different folders for easy 
organizing

• Stopping junk email from reaching your Inbox

• Archiving old messages so they don’t languish in 
your mail folders

• Learning how to look for a message in a haystack

MANAGING EMAIL 
As your email messages start piling up, you eventually need to plan out 

ways to manage them or your Inbox is going to seem like it’s bursting at 

the seams. Thankfully, Outlook makes it easy to choose how you want to 

organize and store messages. In fact, this is where Outlook puts the word 

“manage” in personal information manager and kicks it into high gear. 

Although it may be tempting to let messages turn into a mountain in your 

Inbox, don’t. You can opt for a variety of handy methods for dealing with 

them efficiently:

 •  Store messages in special folders so they stay neat and tidy (OCD 

people are going to love this one).

 •  Delete messages you don’t want to keep so your Inbox isn’t 

clogged.
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 •   Archive messages to move older messages out of the way, yet keep them available 

if needed again.

 • Thin down your incoming deluge of messages by creating rules to sort email.

 • Weed out junk mail before it even makes it into the Inbox.

 • Route messages to the right places using Quick Steps.

In this chapter, you’ll learn essential techniques for keeping ahead of your email stack. 

Organizing Messages with Folders
In case you haven’t noticed yet, every message you receive for a particular email 
service appears in the account’s Inbox folder listed over in the Folder pane. You’re 
not stuck using just    your Inbox to contain your messages. You can use the folder 
structure hierarchy to organize and manage email into logical containers. In the 
same way you use folders to organize files on your computer, you can use folders 
in Outlook to store and sort email messages. 

Each email account includes a set of default folders, one of which is the main 
Inbox for the account where your messages tend to pile up. Other folders may 
include Drafts, Sent Items, Deleted Items, Junk E-mail, and Outbox. (These may 
vary depending on your email service.) Most of the preexisting folders are self-
explanatory based on their names alone, but you can also add more folders to 
help you better organize your messages. For example, you may want to keep 
all your departmental emails in a folder labeled Sales Department, or all of your 
business correspondence in a folder labeled Clients. You can create as    many 
folders as you need, even for temporary projects and tasks. 

TIP You can learn more about using folders to organize other 
Outlook items in Chapter 15, “Using Folders.” Meanwhile, in this 
section, we’ll focus strictly on using folders for email messages.

Making a New Email Folder
Follow these steps to create a new folder:

 1. With the Mail module    displayed onscreen, click the Inbox folder under the 
email service you want to add a folder to (see Figure 5.1).

 2. Click the Folder tab on the ribbon.

 3. Click the New Folder button.
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New Folder button

FIGURE 5.1

Start by choosing which email account you want to add a folder to.

 4. Outlook opens the Create New Folder dialog box, as shown in Figure 5.2. Type 
a name for the new    folder in the Name box.

Type a folder name here

FIGURE 5.2

Use the Create New Folder dialog box to make new folders.
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 5. Leave the other settings intact (Mail and Post Items is selected in the Folder 
Contains box, and the Inbox you selected in step 1 is highlighted in the Select 
Where to Place the Folder list box).

 6. Click OK.

Outlook adds the new folder to the    Folder pane, similar to Figure 5.3. Now you 
can start moving messages to the folder as needed.

New folder

FIGURE 5.3

Outlook adds the new folder to the list.

TIP You can also right-click the Inbox name and choose New 
Folder from the context menu that pops up; then type in a new 
folder name directly without using the Create New Folder dialog 
box.

TIP Adding folders is a key part of using some of Outlook’s 
other message management features, such as rerouting incoming 
emails to designated folders. Sometimes it helps to plan out 
ahead of time what types of folders you might need later, such as 
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a work project or important client you’re corresponding with. You 
can always remove folders you no longer need and    archive any 
old messages.

Moving a Message to Your New Folder
To move a message to a folder, you      can drag and drop it in place. You can also 
use this method:

 1. Click the title of the message you want to move.

 2. Click the Home tab.

 3. Click the Move button.

 4. Select the name of the folder where you want to place the message (see 
Figure 5.4).

FIGURE 5.4

Use the Move menu to move selected messages around in your folder structure.

If the folder you want to use isn’t listed in the Move menu, click the Other Folder 
option and use the  Move Items      dialog box to choose your folder.

Working with Folder Contents
While we’re on the subject of folders, let’s go over the ways you can work with 
them, view their     contents, and purge contents you no longer want to keep.

 • To view any folder in your Folder pane, click the folder name. The Mail 
module immediately displays a list of contents, and if the Reading pane is 
displayed, you can view entire messages.

 • To rename a folder you’ve added yourself, click its name twice and type in a 
new name, or right-click it and choose Rename Folder.
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 • To remove a custom folder, right-click it and choose Delete Folder (see 
Figure 5.5).

FIGURE 5.5

Oh, that handy right-click menu— it’s a time-saver.

 • To move the folder, right-click the folder name, choose Move Folder, and then 
choose where to move it.

 • You can copy a folder. Right-click the folder name and choose Copy Folder, 
and then tell Outlook where to copy it to. 

 • To remove a message from a folder, right-click it and choose Delete or press 
the Delete key, or click the Delete button on the Home tab. So many deletes. 
As soon as you activate a Delete command, Outlook moves the message to 
the Deleted Items folder. 

 • To empty out your Deleted Items folder, right-click the folder name and 
choose Empty Folder. A prompt box appears, telling you that you’re about to 
delete stuff forever. Click Yes to make it happen.

 • To clean out your Junk E-mail folder, right-click the folder and choose Clean 
Up Folder. A prompt box appears, warning you that you’re about to move 
messages to the Deleted     Items folder; click Clean Up Folder to proceed.
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TIP Your Sent Items folder keeps  a copy of all the emails you 
send. This feature is turned on by default, which makes it a nice 
safeguard in case you need to find a message later. 

You can learn more about working with Outlook folders in Chapter 15, including 
how to manage other data types in them.

Routing Messages with Quick Steps
You can use Outlook’s Quick Steps feature to perform multiple actions on 
your email messages with just one click. For example, you might want to flag a 
message for follow up     later and move it to a special folder. Rather than do the two 
actions separately, why not do them at the same time? That’s where Quick Steps 
come into play.

Outlook stores Quick Steps in the Quick Steps gallery on the Home tab when 
you’re using the Mail module. You can scroll through the gallery to view them or 
expand the gallery to view all of them at once. Outlook even includes a few preset 
Quick Steps you can take advantage of:

 • Move To—If you find yourself moving messages to the same folder over 
and over, designate it as the Move To folder and use this Quick Step to 
immediately relocate messages.

 • To Manager—This opens a message form that’s automatically preset with a 
designated recipient, such as your manager (hence the name), along with the 
forwarded message.

 • Team Email—Use this Quick Step to send a new message to everyone on a 
team. All the member’s email addresses are saved and preloaded in the form 
window, ready to go. 

 • Done—This marks the selected message as read, completed (with a Mark 
Complete flag), and moves it to a designated folder—three things at once.

 • Reply and Delete—This one opens a reply form to send back a reply and also 
moves the original message to the Deleted Items folder.

To practice using one of the default Quick Steps, you can try out the one that 
moves messages. While viewing your Inbox messages in the Mail module, select 
the message you want to dispatch (click it or tap it to select it). Next, make sure 
the Home tab is displayed     and click the Move to: ? Quick Step from the Quick 
Step gallery, as shown in Figure 5.6. If the Move to: ? option isn’t in view, scroll 
through the gallery to locate it.
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Quick Steps gallery

Click here to expand the gallery and view all the Quick Steps

FIGURE 5.6

Use the Quick Steps gallery to apply automated tasks to your messages.

When you activate the option, the First Time Setup dialog box appears, similar 
to Figure 5.7. The same box opens for some of the other Quick Steps the first 
time you use them. That’s because you need to specify people or folders first so 
Outlook can carry out the actions. To designate a folder to move the selected 
message to, click the     drop-down arrow and specify a folder name. 

FIGURE 5.7

Use the First Time Setup dialog box to  tell Outlook which folder to move messages to.

The Mark as Read check box is also conveniently selected. You can leave it 
checked if you want to consider the message read; uncheck it if you want to move 
it and treat it as not read yet. 

Finally, click the Save button. Outlook saves the folder name as your designated 
folder and adjusts the Quick Step name accordingly. The next time you want to 
move a message, click the option listed in the Quick Steps gallery, and Outlook 
takes care of the relocation for you. You can use the Quick Steps gallery on the 
Home tab to make your selection, or you can right-click the message, choose 
Quick     Steps, and then choose the name of your step.
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TIP Need to make a folder? Back up to the previous section to 
learn how to add folders to your Inbox to organize messages.

As you can imagine, you can create different Quick Steps to handle various ways 
you want to process email messages. You can move, copy, and delete messages, 
change their status from read to unread, assign categories and flags, generate 
automatic message responses, turn them into appointments, and so on. You can 
assign as many actions to a Quick Step as you want. 

To build a custom Quick Step, choose the Create New option from the Quick 
Steps gallery. This opens the Edit Quick Step dialog box, shown in Figure 5.8, and 
you can choose actions, folders, even type out ToolTip text to pop-up to remind 
you what the step does when you hover the mouse pointer over the Quick Step 
name. Yes, those Microsoft     people have thought of everything. 

FIGURE 5.8

Build your own Quick Steps with the tools in this dialog box.

You can open the Manage Quick Steps dialog box (see Figure 5.9) to make 
changes to actions associated with Quick Steps or remove Quick Steps you no 
longer want. From the Quick Steps gallery, select the Manage Quick Steps option 
to display the dialog box. Choose which Quick Step you want to edit, then click 
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the Edit button to make changes to the associated actions, or click the Delete 
button to remove it entirely from the list. You can also duplicate a Quick Step 
and tweak it slightly to create     a new step. Go wild and make Quick Steps for 
everything—it’s fun.

FIGURE 5.9

Manage your Quick Steps from this dialog box.

TIP What? Don’t like the order of your Quick Steps in the 
gallery? Reorder them in the Manage Quick Steps dialog box. Use 
the arrow buttons to reposition how a step is listed in the bunch.

Managing Incoming Messages with Rules 
How would you like to set a few rules for your email messages, such as telling 
all the emails from a certain     friend to go jump in a Boring folder, or put all the 
messages from your boss into a Do This Now folder? You can set rules in Outlook 
that help you sort through your email and put them in special locations, among 
other actions. Rules can help you move, copy, delete, reply to, forward, and 
redirect your email. You can choose from Outlook’s preset rules or create brand 
new ones. Are you ready to lay down the law? Let’s break out the rule book.

You can build rules with help from Outlook’s Rules Wizard, a step-by-step process 
for creating a rule (click the Advanced Options   button in the Create Rule dialog 
box to summon the wizard for help). However, one of the easiest ways to build a 
rule is to grab an example of an existing message you want to create a rule for, 
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such as an email from a certain person that you always want routed to a certain 
folder, and build on it. With the Mail module displayed, follow these steps:

 1. Select the message you want to turn into a rule.

 2. Click the Home tab.

 3. Click Rules (see Figure 5.10).

Rules button

FIGURE 5.10

Activate the Rules menu to find the Create Rule command.

 4. Click Create Rule to open the Create Rule dialog box, shown in Figure 5.11.

 5. Use the conditions check boxes to set     the criteria for the email. You can specify 
messages from that particular sender, identify subject matter to recognize, or 
who the message was originally sent to, for example.

 6. Under the Do the Following group, choose what you want Outlook to do when 
it encounters these same message types in the future, such as moving them to 
a specified folder.

 7. Click OK and the rule is set for any incoming messages resembling the criteria 
you specified. 
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FIGURE 5.11

The Create Rule dialog box is the place to set criteria for a message rule.

 8. Outlook asks if you want to run the rule immediately. Click the check box and 
click OK to do so, or click OK to exit without running the rule yet.

You can manage any rules you create with a little help from the Rules and Alerts 
dialog box, shown in Figure 5.12. To find your way to this box, click the Rules 
drop-down arrow on the Home tab and choose Manage Rules and Alerts. You can 
also access the box through Outlook’s Backstage view; click the File tab, click Info, 
and then click Manage Rules and Alerts.

FIGURE 5.12

Manage your rules with the Rules and Alerts dialog box.
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 • To turn off a rule, deselect its check box. 

 • To remove a rule, select it and click the Delete button.

 • To edit a rule, select it and choose Change Rule, Edit Rule Settings.

 • To add a new rule, click New Rule.

When you finish with rules, click OK to     exit the dialog box.

Controlling Junk Email
Junk email is a broad term covering advertising emails, unsolicited bulk emails, 
spam, or just about anything sent to your email address without your consent. 
Billions of spam emails are    sent daily, and they’re not always just about advertising 
something. Spam email can also be criminal in nature, generated by hackers 
and “phishers” trying to steal your identity or personal information for nefarious 
reasons. Thwarting junk email from reaching your Inbox requires some filtering on 
Outlook’s part. Although it can’t catch everything all the time, Outlook’s filtering 
tools do a pretty good job of sorting out the bad stuff and placing it in a special 
folder marked for such unworthy messages. 

You can even fine-tune the sensitivity settings to low or high to suit your needs. 
Choose from the following options:

 • No Automatic Filtering—This setting means there’s no filtering happening at 
all. Junk mail can flow freely into your Inbox.

 • Low—Some junk mail still gets through, but the worst of it is tossed away.

 • High—The most ruthless setting; nothing gets through, sometimes not even 
legitimate emails (be sure to check the Junk E-mail folder periodically to see if 
anything important gets tossed in by mistake). 

 • Safe Lists Only—This setting allows only emails from specified companies and 
individuals (from your safe recipients list) to make it into your Inbox. You have 
to identify senders first in a special Safe Senders list (sort of like a guest list for 
your email, and only the invitees make it into the party).

In addition to setting a filtering level, you can also choose to go ahead and 
permanently delete junk email when it’s found, disable links in suspected phishing 
messages, or display a warning prompt for suspicious domain names for a 
heads up. 
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To adjust your junk mail settings, follow    these steps:

 1. From the Mail module, click the Home tab. If you have more than one email 
service, select the account’s Inbox first.

 2. Click the Junk drop-down arrow, shown in Figure 5.13.

FIGURE 5.13

Look for the Junk drop-down menu on the Home tab.

 3. Click Junk E-mail    Options. The Junk E-mail Options dialog box opens to the 
Options tab, as shown in Figure 5.14.

FIGURE 5.14

Set any junk email protection levels in this dialog box.
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 4. Click a protection level.

 5. Click OK.

You can also help Outlook identify junk email by pointing it out when you find it in 
your Inbox. Right-click the icky message from the list, click Junk, then choose the 
Block Sender option. 

If you find the filter dumping legitimate messages into the Junk E-mail folder, 
display the folder’s contents (click the folder name in the Folder pane), right-click 
the message from the list, and choose    Never Block Sender or Not Junk 
(see Figure 5.15).

FIGURE 5.15

Un-junk a legitimate message using the right-click menu.

TIP If you’re concerned Outlook might identify email messages 
from someone as junk, like the weekly family updates from Uncle 
Marvin, you can add the individual to your Safe Recipient’s list. 
From the Junk E-Mail Options dialog box (see Figure 5.14), click 
the Safe Recipients tab and click Add, and then    type in the user’s 
address.
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Archiving Messages
Sure, deleting old messages is a great way to clean out your Inbox, but sometimes 
you need to hang on to    your messages for posterity, or in case you need to 
refer to them again to recall an exchange. You can archive messages, sort of like 
putting them into storage, but without the mothballs or monthly rental fee. 

You can archive manually or automate the task. Outlook’s AutoArchive tool is 
perfect for taking care of archiving tasks in the background without any help from 
you. You can set different archiving tasks for different folders. For example, you 
can instruct the tool to automatically archive messages in your Inbox that are older 
than 3 months and move them to a special archive folder. 

By default, Outlook is set up to archive messages to a file named archive.pst. 
You can specify another location for your archive files as well as specify more 
descriptive filenames. 

Manually Archive Messages
If you’re doing a little folder cleaning, you can manually archive messages. For 
example, you might    be wrapping up a work project and need to put all the email 
messages associated with it into an archive file.

To manually archive messages, follow these steps:

 1. Click the File tab.

 2. Click Info.

 3. Click Cleanup Tools (see Figure 5.16).

 4. Click Archive to open the Archive dialog box shown in Figure 5.17.

 5. Click the folder you want to archive.

 6. Choose a cutoff date, such as items older than 6 months.

 7. Choose an archive file location (click the Browse button, navigate to the 
location, and specify    a more descriptive filename), or use the default filename 
and locations.

 8. Click OK, and Outlook archives the messages.
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FIGURE 5.16

Use the Backstage view to  find your way to Outlook’s cleanup tools.

FIGURE 5.17

Use the Archive dialog box to manually archive old messages.
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Setting Up Automatic Archiving
You can instruct Outlook to perform automatic archiving for you. You can set 
automatic archiving for    individual folders or the Inbox in general. To set up 
automatic archiving, follow these steps:

 1. Select the folder or subfolder you want to archive, such as your Inbox or an old 
project folder.

 2. Click the Folder tab.

 3. Click the AutoArchive Settings button.

 4. Outlook opens the Junk E-mail Properties dialog box to the AutoArchive tab 
of tools, as shown in Figure 5.18. Click Archive this folder using these settings 
option.

FIGURE 5.18

Use the AutoArchive feature to automatically archive old messages.

 5. Specify the age of the messages, such as older than 3 months.

 6. Specify a location for the archived file, or use the default location.

 7. Click OK.
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Each folder can have its own archiving    settings, which is handy if you don’t want 
some folders tampered with, but others are good to square away. 

TIP Want to check out how much room is being consumed in 
your Inbox? Switch over to Backstage view (click the File tab) and 
click the Cleanup Tools button, then click Mailbox Cleanup. This 
opens the Mailbox Cleanup dialog box. Click the View Mailbox 
Size button to check out how much room is taken up by your 
messages in the various folders. Based on what you see, you 
may decide you need to clean up some folders and archive old 
messages.

Searching for Messages
As your digital stack of email grows, so does the inevitable need to search through 
them for a particular message. If you’re worried that searching for a message 
may be like looking for a   needle in a haystack, don’t sweat it. Outlook has tools 
you can use to look for messages. In fact, Outlook taps into the Windows 
Search technology, which means you can even search for Outlook items from the 
Windows Start menu (Windows 7) or using the Windows 8 search screen.

TIP You can learn more about searching for Outlook items in 
Chapter 16, “Using Search.” 

Conducting a Quick Search
When you select an Inbox to view in the Mail module, a search box appears at 
the top of the list, much    like the one found in Figure 5.19. You can click in the 
box and type any keyword or words you want to search for, whether it’s a name, 
subject title, or a word within the message body. As soon as you start typing, 
Outlook starts searching. Any matches are listed, newest emails first, similar to 
Figure 5.20. Outlook also opens a Search tab on the ribbon with additional search 
tools you can access and apply.
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Search box

FIGURE 5.19

Use the search box at the top of the message list to search for messages in that particular 
Inbox or folder.

You can narrow the search by adjusting the keyword or words you search for, or 
by tweaking the search criteria, such as searching subject lines or recipient names. 
To add search    criteria, select among the Refine group of tools on the Search 
tab and then type in your refining keyword or words in the search box, similar to 
Figure 5.21. You can also click the drop-down arrow on the search box to change 
which folder or Inbox you search.

When you finish with your search, click the Close Search button on the Search tab.

TIP Performing a sort can help you find messages by subject, 
name, or date. To perform a    quick sort, click the sort category at 
the top of your message list, such as Subject or From. If you turn 
off the Reading Pane, you can view more sort categories. 
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FIGURE 5.20

Outlook displays possible matches and opens a Search tab of tools.

FIGURE 5.21

Use the Refine group of tools to refine your search further.

Making Search Folders
You can use Outlook’s Search folders to speed up searching tasks. A Search 
folder gives you a spot to look for certain kinds of messages regardless of where 
they’re actually located. It’s    rather like a catalog of messages pertaining to a set 
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of criteria. Search   folders can save you quite a bit of time and energy otherwise 
searching through a vast amount of messages. Plus, after they’re established, 
Outlook keeps your Search folders up to date.

Outlook offers several preset Search folders you can use. For example, the Mail 
Flagged for Follow Up folder shows only messages you’ve flagged, whereas the 
Unread Mail folder shows only messages you haven’t read yet.

To create a custom search folder, click the New Search Folder button on the 
Folder tab. The New Search Folder dialog box opens, similar to Figure 5.22. 
Choose the type of Search folder you want to add. If you’re making a custom 
folder, click the Choose button to fill in any additional information required by the 
type. When you finish filling out details, click OK. 

FIGURE 5.22

The New Search Folder dialog box.

To search your Search folder, click    the folder name and a list of messages 
immediately appears. To exit the folder, click the Inbox again. 

See Chapter 16 to learn more about searching in Outlook.
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THE ABSOLUTE MINIMUM 
Now you know how to manage and organize your vast pile of accumulating email 
messages. In this chapter, you learned the following:

 • You can use Outlook’s folder hierarchy to organize messages in an orderly 
fashion; just add new folders when you need them and move messages 
around.

 • Use Outlook’s Quick Steps to perform multiple actions on your messages, 
such as sending particular ones to a certain folder and flagging them with 
priority status.

 • You can use message rules to direct the flow of incoming email, such as 
sending messages from your colleague to a project folder or sending routing 
messages from your brother-in-law to an Avoid Reading folder. 

 • Turn on Outlook’s filtering tools to stop the flow of junk email to your Inbox.

 • You can archive older messages to get them out of the way, yet keep them 
available if you need to refer to them again.

 • You can search for a message using the Search box at the top of the message 
list, easy-peasy.
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backing up data, 332-333
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Calendar, 139-140

appointments, recording, 154-157
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contacts, options, 184-186
themes, 55-56
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Quick Click Category, 266
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sharing, 273
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Color Category Picker, 267
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Auto-Complete list,  180-181
auto-resolution, 181
categories, sending group mail, 179-180
changing

company name  field, 189
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removing from Favorites list, 190
searching, 186-187
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using in other  programs, 248
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Word, 248
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contents, 97-98
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controlling junk email,  105-107
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copying
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contacts, 174-175
ribbon, 26
Task Peek view, 205
tasks, 205
To-Do List view, 205
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D
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data files
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dates
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delegation, sharing folders, 256-257
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attachments, opening, 85-86
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file attachments, 82
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forwarding, 127-129
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shapes, 133
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junk email, controlling, 105-107
Microsoft accounts, 45-47
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making new email  folders, 94-97
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working with folder contents, 97-98
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printing, 313-314
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privacy settings, 222
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recovering deleted, 279
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Help, 16-18
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Social Connector pane, 220–221
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HTML, 70, 120
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I
iCalendar, 243
iCloud, 240-241
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Calendar icon, 140
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IMAP folders, 279
IMAP (Internet Message Access 
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Import and Export  Wizard, 242, 331
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syncing smartphones and tablets, 242

incoming messages, managing with rules, 
102-105
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starting from Outlook, 345-348
starting in Word, 349

Mail Merge Contacts  dialog box, 345-346
Mail Merge Recipients  dialog box, 348
managing

data with folders,  280-281
folders, 277-279
incoming messages with rules, 102-105
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MAPI (Messaging Application 
Programming), 44

Mark Complete,  To-Dos, 210
marking messages as read/unread, 87-88
Master Category list, 270
Medium Book Style,  printing contacts, 323
Meeting form, 159
meetings (Calendar), 158

sending out invites,  159-160
tracking invites, 160-161

Memo Style
notes, 229
printing, 312
printing contacts, 324

message files, saving, 80-81
messages. See also email

archiving, 108
automatically, 110-111
manually, 108

attaching files, 83-85
attachments, opening, 85-86
categorizing, 88-89
checking for new, 74
color coding, 90
composing, 66-70
deleting, 78
flagging, 88
formatting, 118-120
forwarding, 77-78
incoming messages, managing with 

rules, 102-105
marking as read/unread, 87-88
moving to folders, 97
reading, 70-73
replying to, 76-77
routing with Quick Steps, 99-102

saving, 79
drafts, 79-80
message files, 80-81

searching for, 111
quick searches, 111-112
search folders, 113-114

sending, 66-70
Message window, 66
Microsoft accounts, 9-10, 46

email, 45-47
sharing calendar and contacts, 246-247
sharing calendar and contacts, Outlook.

com, 243
Microsoft Exchange, 44
Microsoft Outlook Account Setup 

Wizard, 9
mini toolbar, 29
Monthly Style, printing, 316
mouse, ClickLock  feature, 277
Move Items dialog box, 97
moving

data files, 328-329
syncing smartphones and tablets, 

241-242
folders, 278-279
messages to folders, 97

N
names, removing from printouts, 320-321
naming folders, 278
navigating Calendar,  142-145

to dates, 146-147
Weather bar, 147-148

navigation bar, 14, 31-34
new features, 7-8
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non-default folders, sharing, 255-256
notes, 6

assigning categories  to, 228
creating, 226-228
emailing, 230
organizing, 230
saving, 228-230

Notes, 225-226
assigning categories to notes, 228
creating notes, 226-228
keyboard shortcuts,  231-232

notes views, 303

O
Office 365, 8
OneNote, tasks

creating, 213
linking, 210-213
sending, 210-213

online pictures, inserting in email, 132
online services,  adding, 62
opening

attachments to  messages, 85-86
Personal Folders,  282-283
shared mailbox  folders, 254

options, changing (Contacts), 184-186
organizing

messages with  folders, 94
creating new email folders, 94-97
moving messages to folders, 97
working with folder contents, 97-98

notes, 230
.ost, 327

Outlook
history of, 5-6
new features, 7-8
overview, 4-5

Outlook.com, sharing calendar and 
contacts, 243-247

Outlook icon, 13
Outlook items

color categories, assigning, 264-266
finding

Advanced Find, 292-295
Instant Search, 286-288
to/from specific people, 289-291

Outlook Today screen,  tasks, 205

P
Page Setup dialog box,  317-318
panes, 34

Folder pane, 34-36
hiding/displaying, 143

People pane, 72-73
who can see  content, 223

Reading pane, 36-37, 70
Social Connector pane, 220-221
To-Do bar, 38-40

partial word searches, Instant Search, 288
peeks, 38-40
people, 6
People Hub, 168, 302

contact cards, editing, 169
People pane, 72-73, 290

Contact photo, 223
who can see it, 223
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People Peek, 189-190
People views, 301-302
permissions

checking, 250
folders, 279
for folder types, 253

Personal Folders, creating, 282-283
personal information  manager (PIM), 3
Phone Directory Style

printing, 316, 325-326
printing contacts, 324

photos, changing account photos, 59-62
pictures

adding to contacts, 175
inserting

in email, 129-131
online pictures in  email, 132

PIM (personal information manager), 3
plain text, 70, 120
policy settings, folders, 279
POP3 (Post Office  Protocol 3), 44
Print dialog box, 312-313, 319
printing

Booklet Style, 316
calendars, 321-323
Calender Details Style, 316
Card Style, 316
contacts, 323-325
Daily Style, 315
email, 313-314
Memo Style, 312
Monthly Style, 316
overview, 312-313
Phone Directory Style, 316, 325-326
print styles, 314-316
Table Style, 312

Tri-fold Style, 316
Weekly Agenda Style, 315
Weekly Calendar Style, 315

print options, configuring, 317-320
print preview, 313
print styles, 312-316

copying, 320
priority options, email,  121-122
privacy settings,  Facebook, 222
Profile page, 59
Program Data folder, 295
program window, 13-15

sizing, 15-16
program window controls, 15
properties, folders, 279
Properties dialog, 253
.pst (Personal Folders)  files, 327, 338

creating, 282-283
repairing with Scanpst, 338-340

Public Folders, 258-259
publishing calendars  online, 163
purging folders, 279

Q
queries, Instant Search,  287-288
Query Builder, 294-295
Quick Access toolbar, 13, 27-28
Quick Click Category, 266

setting, 266-267
Quick Click Flag, 197
Quick Flag icon, 208
Quick Parts, email, 122-124
quick searches, searching messages, 

111-112
Quick Steps, routing  messages, 99-102
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R
reading messages, 70-73
Reading pane, 36-37, 70
rebuilding indexes, 295
receipts, controlling email, 127-129
recording

appointments in Calendar, 154-157
events in Calendar, 149-153

recovering deleted  folders, 279
Recurrence dialog  box, 153
recurring tasks, 199-200
reminders (Calendar),  setting, 157-158
removing

color categories, 268
contacts from Favorites list, 190
names from printouts, 320-321

renaming folders, 278
repairing .pst with Scanpst, 338-340
replies to email, controlling, 127-129
replying to messages, 76-77
resetting views, 306-307
reviewing tools, 121
ribbon, 13, 22

customizing, 26
displaying, 26
drop-down arrow, 24
File tab, 25
Folder tab, 25
galleries, 24
hiding, 26
Home tab, 22-25
Send/Receive tab, 25
View tab, 25

Rich Text format, 70, 120
routing messages with Quick Step, 99-102

RSS feeds, 135
subscribing to, 135-137

rules
managing incoming  messages, 102-105
running on folders, 279

Rules Wizard, 102
running rules on folders, 279

S
saving

calendars, 164
messages, 79

drafts, 79-80
message files, 80-81

notes, 228-230
Scanpst, repairing .pst,  338-340
Schedule view,  Calendar, 145
ScreenTips, 26
Search field (Windows), 287
search folders, 113-114,  290-291
searching

Advanced Find, 292-295
contacts, 186-187
for folders, 280-281
for mail to/from specific people, 

289-291
for messages, 111

quick searches,  111-112
search folders,  113-114

Instant Search, 286-287
partial word  searches, 288
queries, 287-288

troubleshooting, 295
security, Social  Connector, 221

Facebook, 221-223



364 SENDING

sending
group email, using categories, 179-180
invites for meetings (Calendar), 159-160
messages, 66-70
tasks to OneNote,  210-213

Send/Receive Groups  dialog box, 75
Send/Receive tab,  ribbon, 25
sensitivity options, email, 121-122
Sent Items folder, 99
shapes, inserting in  email, 133
Shapes gallery, 134
shared mailboxes, 258-259
shared mailbox folders, opening, 254
SharePoint, connecting to Outlook, 

259-261
sharing, 240

calendars, 162-163
Outlook.com,  243-247
syncing smartphones/tablets, 243

color categories, 273
contacts, Outlook.com, 243-247
folders, 250-252

delegation, 256-257
mailbox folders,  252-254
non-default folders/ subfolders, 255-256
with a second  computer, 241

showing Social Connector pane, 220-221
signatures

adding to email,  124-127
editing, 127

sizing program window, 15-16
Small Booklet Style, printing contacts, 323
smartphones, syncing,  240-241

importing/exporting, 242
moving data files,  241-242

sharing calendars, 243
Social Connector, 215-216

configuring, 216-217
security, 221

Facebook, 221-223
setting up social networking accounts, 

217-219
turning off contact  photos, 220

Social Connector pane, showing/hiding, 
220-221

social networking accounts, setting up 
Social Connector, 217-219

sorting folders, 279
specific people, finding mail to/from, 

289-291
start date, calculating  tasks, 196
starting

mail merge
from Outlook, 345-348
in Word, 349

Outlook
Windows 7, 10
Windows 8, 11-12

status bar, 14
Step by Step Mail Merge Wizard, 347
storing data files in the cloud, 337-338
subfolders, sharing, 255-256
subscribing to RSS feeds,  135-137
switching accounts, 58
syncing

smartphones, 240-241
importing/exporting, 242
moving data files,  241-242
sharing calendars, 243
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tablets, 240-241
importing/exporting, 242
moving data files,  241-242
sharing calendars, 243

system requirements, 8

T
Table Style

notes, 229
printing, 312

tablets, syncing, 240-241
importing/exporting, 242
moving data files, 241-242
sharing calendars, 243

task form, 195
task options, configuring,  206-207
Task Options dialog  box, 207
Task Peek, task list, 204
Task Peek view,  customizing, 205
task requests, 201

accepting, 202-203
creating, 201-202

tasks, 6, 193
calculating start  date, 196
completing, 197-199
creating, 194-196

Type a New Task Row, 196-197
customizing, 205
entering details, 199
Journal, 235
linking to OneNote,  210-213
recurring, 199-200
sending to OneNote,  210-213
viewing, 203-205

task views, 302-303

themes, changing, 55-56
timeline view, Journal, 236
tips for using color categories, 273-274
title bar, 13
To-Do bar, 38-40
To-Do List view,  customizing, 205
To-Do’s, 193

creating, 208-210
Follow Up, 209
Mark Complete, 210

toolbars, 28-29
mini toolbar, 29
Quick Access toolbar, 13, 27-28

tools
Auto Account Setup  tool, 50
Go To tools, 147

touchscreen technology, 8
tracking invites for meetings (Calendar), 

160-161
Tracking feature, 160
Tri-fold Style, printing, 316
troubleshooting  searches, 295
turning off

contact photos, Social Connector, 220
ScreenTips, 26

U
updating folder list, 279
upgrading to color categories, 270-272

V
viewing

folders on server, 279
tasks, 203-205

view modes, Calendar, 141
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views, 297
Address Card view, 323
applying to folders, 304
Backstage view, 47-48
calendar views, 300-301
changing, 298-299
Compact view, 300
contacts, 187-188
copying, 307
custom views, 305-306

conditional formatting, 307-308
editing contact data, 189
email views, 299-300
Group By views, 189
IMAP accounts, 299
Journal, 236
journal views, 303
notes views, 303
People views, 301-302
resetting, 306-307
Table views, Journal, 236
task views, 302-303
timeline view, Journal, 236

View tab, 298
ribbon, 25
To-Do bar, 40

W-X-Y-Z
Weather bar, Calendar,  147-148
Weekly Agenda Style,  printing, 315
Weekly Calendar Style,  printing, 315
Week view, 145
Windows 7, starting  Outlook, 10
Windows 8, starting Outlook, 11-12
Windows Start Search  field, 287
wizards

Import and Export  Wizard, 331
Import/Export wizard, 242
Microsoft Outlook Account Setup 

Wizard, 9
Rules Wizard, 102
Step by Step Mail Merge Wizard, 347

Word
Outlook Contacts, 248
starting mail  merge, 349

Work Week view, 145
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